
Increasing System Performance
If your machine just meets minimum system requirements, try the following to increase system 
performance:

Close all other applications when using this product.

Have Windows manage your computer's virtual memory settings:

1 Windows 95 users click here  to display System Properties.

2 Click the Performance tab.
3 Click Virtual Memory, and then choose Let Windows Manage My Virtual Memory Settings 
(Recommended).

Defragment your computer's hard drive:

1 Click Start, and then point to Programs.

2 Point to Accessories, and then point to System Tools.

3 Click Disk Defragmenter.

Note    If necessary, install Disk Defragmenter using the Add New Programs icon in Control Panel.

Optimize Windows CD-ROM drive settings:

1 Windows 95 users click here  to display System Properties.

2 Click the Performance tab.
3 Click File System, and then click the CD-ROM tab.
4 Increase the size of the Supplemental Cache for your CD-ROM. Also check that the settings and 
speed in the Optimize Patterns For box are correct.

Related Topics



Audio Performance Problems
Visual Basic Books Online uses the WAVE (*.WAV): Digitized audio type of sound file:

To hear sounds, you must have a sound card that is capable of playing WAVE sounds.

Your sound card uses a special piece of software called a "sound driver" to communicate with your 
computer. In some instances, you may not get any sounds when using Visual Basic Books Online. 
Usually this is because your sound driver is not installed or is configured improperly. If you do not 
hear any sounds, or get an error message saying that there is a problem with your sound card or 
sound driver when you start the program, the WAVE portion of your sound driver may be either 
improperly configured or not installed.

Related Topics



 I got an error message about my sound
The two most common errors about WAVE sounds are:

· "A sound card is required to run Visual Basic Books Online."

· "Visual Basic Books Online cannot get the sound device right now, it's in use elsewhere, try again."

If you receive the first error message, it usually indicates that your sound driver is either not installed, 
not installed correctly, or not configured correctly. If you receive the second error message, it usually 
indicates that your sound driver is in use by another open program. Solve this by closing all other 
open programs, and restarting Visual Basic Books Online.

For more information on troubleshooting WAVE errors, see "I can't hear any sound."

Related Topics



I can't hear any sounds
If sound does not play at all:

1 Check the volume on your sound card or speakers, and turn up the volume if necessary.

2 Check that the speakers are connected to your computer, that the speaker power switch is on, and 
that the batteries (if any) are functional.

3 Check that the audio card software is installed correctly; reinstall it if necessary.

4 Ensure that the audio card is pressed securely into its slot, or change a jumper setting on the audio 
card.

5 If you have both an audio card and special software that bypass the audio card to play sounds 
through the PC speaker, try removing or disabling the PC speaker driver. This product requires 
MPC-compatible audio; it is not meant to run with only the PC internal speaker or any combination 
of that speaker and special software.

Related Topics



Checking Your Sound Card
To ensure that your sound card is installed properly:

1 Windows 95 users click here  to display System Properties.

2 On the Device Manager tab, click the plus sign next to Sound, video and game controllers, and 
then double-click the name of your sound card.
3 On the General tab, look under Device Status to see if the device is working properly.

Note      If your sound driver is not working properly, please contact your sound card manufacturer.

Related Topics



My sounds are "scratchy"
Sound distortion is often caused by sending a higher volume or amplitude of sound than the speakers 
are able to handle. Also, if the volume control on your audio card is set too high, it may cause 
distortion from the amplifier on the audio card. Sometimes lower-quality speakers distort at a lower 
volume than better-quality speakers.

For example, if your audio card or "WAVE file output" volume is set to near maximum, it will cause 
distortion. To change your audio card settings, refer to the manuals that came with your audio card.

To adjust the volume control:

1 Click here  to open Volume Control.

2 Adjust the Volume Controls.
3 Click the Close box.
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My sounds are cut off
Most audio cards can play only one sound at a time; therefore, other products with sound may 
interrupt sounds from this product. Some programs may take over the audio capability and prevent 
other Windows programs from creating sounds.

If you think that you have another program that produces sounds which could interrupt sounds from 
this product, do not run the two programs simultaneously.

Related Topics



My sounds "skip"
If sound breaks up or "skips" periodically, it usually indicates that the CD-ROM drive does not meet 
the full MPC II (Multimedia PC - Level 2) specifications and needs to be upgraded.

You can continue to use your CD-ROM drive to run this program, but sound will continue to skip.

CD-ROM Drive requirements:

· Double-speed CD-ROM: This CD-ROM drive can transfer data from the CD-ROM at 300 KB per 
second while using less than 40% of the CPU bandwidth, and has an average seek time of less 
than 400 milliseconds.

· MS-DOS CD-ROM Extensions (MSCDEX) version 2.2 or later.

Related Topics



Checking and Changing Video Settings
Visual Basic Books Online requires that your video driver supports a screen resolution of at least 640 
x 480 (the program will support higher screen resolutions, and we recommend you use 800 x 600 or 
greater). In addition, the program requires that your video driver is able to display 256 colors.

To check video settings or change them:

1 Windows 95 users click here  to view Display properties.

2 Click the Settings tab.
3 Under Desktop Area, drag the slider.

Note    Your monitor and display adapter determine if you can change your screen resolution.

If your video driver is not working properly, please contact your video card manufacturer.

Related Topics



The display driver supports less than 256 colors
Visual Basic Books Online requires a video driver that supports a screen resolution of at least 640 x 
480 (although the program will support higher screen resolutions). In addition, the program requires 
that the video driver be able to display 256 colors.

To check video settings or change them:

1 Windows 95 users click here  to view Display properties.

2 Click the Settings tab.
3 Under Desktop Area, drag the slider.

Note    Your monitor and display adapter determine if you can change your screen resolution.

If your video driver is not working properly, please contact your video card manufacturer.

Related Topics



My machine "hangs"
If you use accelerated video drivers with more than 256 colors, or high-resolution video drivers, the 
product may not display videos correctly. For example, you may see garbled images, or the product 
may stop running when you play a video.

If you encounter this, change to a standard video mode such as 640 x 480 resolution with 256 colors.

To check video settings or change them:

1 Windows 95 users click here  to view Display properties.

2 Click the Settings tab.
3 Under Desktop Area, drag the slider.

Note    Your monitor and display adapter determine if you can change your screen resolution.
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System Requirements
To run Visual Basic Books Online , you need:

· Personal computer with a 486DX or higher processor running Microsoft Windows 95 or Windows 
NT 3.51 or later

· 8 megabytes (MB) of memory (16 MB recommended for Windows 95)

· 10 MB available hard disk space

· MPC2-compatible CD-ROM drive

· Super VGA or higher resolution video adapter capable of displaying 256 colors or more

· Microsoft Mouse or compatible pointing device

· MPC2-compatible audio board (required for audio and video instruction)
  



Use the Navigation Area
The Navigation Area occupies the left pane of the Main Viewer and is used to navigate through the 
application content. Use the Navigation Area toolbar buttons to view the Table of Contents or to find 
information, as shown below.

Contents. Displays the Table of Contents.

Index. Displays Index entries related to particular topics.

Find. Displays the Find pane, where you can search for a word or topic.

The Navigation Area is separated from the Topic Area (the right side of the Main Viewer) by a sizing 
border that you can drag to change the relative size of both panes.

Related Topics



View Content in the Topic Area
The right pane of the Main Viewer is called the Topic Area. When you select a topic in the Navigation 
Area (the left pane), the text and associated media displays in the Topic Area. Here’s what you can 
view in the Topic Area:

· Selected topics from the Table of Contents

· A topic selected from the Notebook

· A topic selected from the History window

· Items listed in the Index

· Search results from your Find requests

When you click a topic in the Navigation Area, the information is displayed in the Topic Area. You can 
also use the buttons on the toolbar at the bottom of the Topic Area to move backward and forward 
through content information, or to jump to information that is related to the currently displayed topic.

You can print or copy selected (or all) text displayed in the Topic Area.

To change the relative size of both panes, drag the splitter bar between the two panes.

Related Topics



Display Multimedia and Additional Information
In some introductory topics, you will find multimedia icons that you can click to:

· View demonstrations of features and techniques.

· View animations illustrating key concepts.

Here's a list of the icons that you'll see.

Animation. Animations are used in many 
chapters to illustrate complex technical 
concepts.

Demonstration. Narrated demonstrations 
help you learn by watching and listening as a 
developer takes you through the steps of a 
procedure.

Related Topics



Choose a Display Mode
You can view the Table of Contents, Index, or Find features of the Navigation Area in the left pane, 
while displaying information in the Topic Area in the right pane. Or, you can hide the Navigation Area 
and view just the Topic Area.

To display both areas, do one of the following:

Click the Navigation & Topic button on the toolbar.

· From the View menu, click Navigation & Topic.

· Press CTRL+A.

· Point to the left pane, click the right mouse button, and click Navigation & Topic from the 
shortcut menus.

To display only the Topic Area, do one of the following:

Click Topic Only on the toolbar.

· From the View menu, click Topic Only.

· Press CTRL+O.

· Point to the left pane, click the right mouse button, and click Topic Only from the shortcut menu.

Related Topics



Put the Index to Work
To use the Navigation Area to search through an index for Visual Basic Books Online, do one of the 
following:

Click the Index button on the Navigation Area toolbar.

· From the View Menu, click Index.

· Press CTRL+I.

· Point to the Navigation Area, click the right mouse button, and then click Index from the shortcut 
menu.

To Use the Index:

Click the text box and type the first few letters of the word that you want. The Index will scroll to the 
closest entry and list related topics in the box at the bottom. Click an Index entry to display the topic in 
the Topic Area.

Related Topics



Use "Find" to Refine Your Search
To use Find to search for a word or phrase, do one of the following:

Click Find on the Navigation Area toolbar.

· From the View Menu, click Find.

· Press CTRL+F.

· Point to the Navigation Area, click the right mouse button, and then click Find from the shortcut 
menu.

You can type a word or phrase, or select a previous search string from the drop-down list. To search 
for a phrase, enclose the phrase in quotation marks. You can also use Boolean operators to refine 
your search.

Related Topics



Using Boolean Operators
Visual Basic Books Online supports the following Boolean operators in the Find tool.

Operator Description Example
* Matches any 

number of 
characters in a 
word

valid* finds valid, validate, 
validation

AND
+ (plus 
sign)

The logical AND 
( + ) operator 
finds only topics 
that contain all of 
the strings

language AND logic finds 
only topics that contain both 
words

OR
| (pipe)

The logical OR 
( | ) operator 
finds topics that 
contain any of 
the listed strings

language OR logic finds 
topics that contain either 
word

NOT
- (minus)

The logical NOT 
( - ) operator 
finds only topics 
that do not 
contain the string

language NOT logic finds 
topics that contain the word 
language and do not contain 
the word logic

NEAR The NEAR 
operator finds 
only those topics 
within eight 
words

save NEAR print finds only 
those topics that contain the 
two words within eight words 
from each other

Multiple operators can be combined in a single search. The search string is evaluated from left to 
right. You can also enclose a phrase in quotation marks to search for that exact phrase, rather than 
the individual words within it. 

Press ENTER to run the search. When the results list appears, click a topic to view it in the Topic Area. 
The word or phrase for which you searched is highlighted in the displayed topic.



Check Out the Glossary

Click the Glossary button on the toolbar to open the Glossary Help file and search for a word or 
phrase.

Related Topics



Revisiting Topics Using the History Window
To browse through a list of previously visited topics, open the History window by choosing History 
from the Navigate menu, or by pressing CTRL+H.

Click a topic in the History window to display it in the Topic Area. If the Contents pane is active in the 
Navigation Area, the title of the topic displayed in the History window is selected in the table of 
contents.

Note    You must use the mouse to select a topic in the History window. The keyboard keys are 
disabled in this window.

The History window stays on top of the application main viewer until you close it. The window opens 
the same size and location used when last closed. You can move the window or drag its borders to 
suit your needs.



How to Use the Table of Contents
Click on a book title in the Navigation Area to expand the section of Visual Basic Books Online that 
you want to display in the Table of Contents. Then click the item in the Table of Contents to display it 
in the Topic Area.

Use the drop-down at the top of the Navigation Area to choose a subset of Visual Basic Books Online.



Create Notebook Entries
You can use the Notebook to mark topics of interest anywhere in the application and make notes 
about these topics. You can return to these notes at any time during the current session or during a 
future session.

To open the Notebook, do one of the following:

Click Notebook on the toolbar.

· From the Edit menu, click Notebook.

· Press CTRL+K.

· Point to the Navigation or Topic Area, click the right mouse button, and then click Notebook from 
the shortcut menu.

Add or delete a Notebook entry

Add, edit, or delete your notes

Display a Notebook entry in the Topic Area

View notes for current topic

View Help in the Notebook

Print a Notebook entry and/or your notes



To add a topic to the Notebook, click the topic in the Navigation Area, and then:

Click the Notebook icon on the main toolbar to open the Notebook window.

Click the Add To Notebook icon on the Notebook window toolbar to add the topic to the Notebook.

To delete a Notebook entry, select it from the Notebook list and click the Delete icon.



You can add new or edit existing notes. First, add the topic to the Notebook, or select an existing 
Notebook entry, then click in the right pane and type your notes.

Click the Add To Notebook icon to attach your notes to the existing Notebook entry.

You can paste text or graphics from the Topic Area into your notes in the Notebook window. Copy the 
information to the Clipboard and then do one of the following:

Click the Paste toolbar button.

· Press CTRL+V.

· Point to the Notes pane, click the right mouse button, and select Paste from the shortcut menu.

Note    When editing your notes in the right pane, you can use the right-click menu to choose from the 
standard Windows editing commands: Undo, Cut, Copy, Paste, and Select All.



To display a topic entry from the Notebook window in the Topic Area, select the topic in the Notebook 
window and click the Go To Topic icon, or simply double-click the topic in the Notebook window.



Click the Notebook icon above the Topic Area to view the notes for the currently displayed topic.



You can view What's This Help for the toolbar buttons and windows in the Notebook. Simply point to 
the button or window for which you want help, right-click the mouse, and then click What’s This?.



Printing Notes and Notebook Entries
You can print all of the topics that are listed in your Notebook, or print only the current Notebook entry. 
You can also print your notes for the current entry, or print all your notes.

Click the Print icon to open the Print dialog box, and then click your choice of the options defined 
below.

Choose one of the following:

· Print current Notebook topic. Prints the selected Notebook entry.

· Print all Notebook topics. Prints all topics that are stored in your Notebook.

You can choose one or both of the following to print the Notebook topic(s) with or without your notes.

· Include Topic Text. Prints the selected entry or all Notebook entries.

· Include Notes. Prints notes that are associated with the selected entry, or all notes that you’ve 
added to your Notebook entries.

Click Print to print your choice, or click Cancel to close the dialog box without printing.

Related Topics



Printing Topics and Other Information
You can print the topic that is displayed in the Topic Area. To print, do one of the following:

Click the Print icon on the main or Notebook toolbar.

· From the File menu, choose Print.

· Press CTRL+P.

· Point to the left pane, click the right mouse button, and then click Print from the shortcut menu.

You can highlight a portion of text and print just the selection, or print the entire topic. When you 
choose Print, a standard Windows Print dialog box appears; simply enter your choices and then 
choose OK.

Related Topics



"What's This?"—Help About Toolbar Buttons, Menus, and Windows
When you want to find out what an item on the screen does, point to the screen element for which 
you want Help, right-click the mouse, and then click "What’s This?".



Use Menu Commands
Click a menu command to see a description of what it does.

File Menu

Print

Exit

Edit Menu

Copy

Notebook

Navigate Menu

Next Topic

Previous Topic

Back

History

Related Info

View Menu

Topic Only

Navigation & Topic

Contents

Index

Find

Magnify

Internet Launch Dialog

Help Menu

Help Topics

Glossary

About



When the standard Windows print dialog box appears, enter or click your choices, and then click OK 
to print.

If you are printing from the Notebook window, click your choices from the Print dialog box, and then 
click OK to print.

Related Topics



Closes the application.



Copies the text or graphics that you have selected in the Topic Area or Notebook. To paste your 
section into another application, open the application and then select Paste from the Edit menu, or 
use the paste CTRL+<KEY> combination for that application.

You can paste text or graphics from the Topic Area into your notes in the Notebook window. Copy the 
information to the Clipboard and then do one of the following:

Click the Paste toolbar button.

· Press CTRL+V.

· Point to the Notes pane, click the right mouse button, and then choose Paste from the shortcut 
menu.



Opens the Notebook, where you can mark topics of interest and make notes about these topics.



Moves to the next topic in the Navigation Area.



Moves to the previous topic in the Navigation Area.



Moves back through the topics that you've viewed.



Displays a list of the topics that you’ve viewed. Click a topic in the History window to display the topic 
in the Topic Area.



Displays a list of topics related to the current topic. Click a topic to display it.

This is the same as clicking Related Information at the bottom of the Topic Area.

Note    These options appear dimmed if no jump to related information in the Library is available.



Displays both the Navigation Area and Topic Area.



Displays the Topic Area only.



Displays the Table of Contents in the Navigation Area.



Displays the Index in the Navigation Area.



Displays the Find pane in the Navigation Area.



Displays a menu from which you can reduce or enlarge text in the Topic Area and in any text viewer 
(Sample Code, Tips, Closed Caption). Simply select one of the following options:

· 75%: Reduces all text to 75% of its normal size.

· 100%: Returns all text to its normal size.

· 150%: Enlarges all text to 150% of its normal size.

· 200%: Enlarges all text to 200% of its normal size.



Displays a dialog box when you launch the Internet Explorer from Visual Basic Books Online. 



Opens this Help file.



Displays a glossary of terms and definitions in Help file format.



Displays name, version, and copyright information for this application.



Shortcut Menus
A shortcut menu is available in the main window and most supplementary viewers at all times, 
including the right pane of the Notebook window. The commands on this menu change depending 
upon where you right-click. Simply right-click to display the menu, and then click your choice.

Click the menus below to display a brief description of each command.

Navigation and Topic Area Options

These options appear when you right-click in the Navigation or Topic Area in the main viewer.

A check mark on this menu indicates the currently active pane or window and mode.

When Topic Only is selected, you can restore the Navigation Area by choosing Navigation & Topic 
from the menu.

Navigation & Topic

Topic Only

Contents

Index

Find

Notebook

History

Print

Copy

Back

Help Topics

What  ’  s This?  

Notebook Window Options

The left pane of the Notebook window displays these options.

Add to Notebook

Delete Selected Item

Goto

Print

Paste

Help Topics

What  ’  s This  

The right pane of the Notebook window displays these standard Windows editing commands.

Undo

Cut

Copy

Paste

Delete

Select All



History Window Options

These options appear when you right-click the History window

Help Topics

What  ’  s This  

Note:    The shortcut menu is not available in the Animation, Demonstration, and Video viewers.



Displays both the Navigation and Topic Areas in the main viewer.



Displays only the Topic Area in the main viewer. You can restore the Navigation Area by choosing 
Navigation & Topic from the menu.



Displays the Table of Contents in the Navigation Area.



Displays the Index pane in the Navigation Area.



Displays the Find pane in the Navigation Area.



Opens the Notebook window.



Opens the History window.



Opens the standard Windows Print dialog box.



Copies the selected text, or the entire topic displayed in the window, to the Clipboard.



Moves to the previously viewed topic.



Opens the Books Online Help file.



Context-sensitive Help for the active screen element.



Adds the displayed topic to the Notebook. You can add notes to this entry as well.



Deletes the selected Notebook entry.



Deletes the selected text in your Notes window.



Goes to the selected Notebook topic and displays the text and associated media icons in the Topic 
Area.



Opens the Print dialog box. You can print a selected Notebook entry or all entries with or without your 
notes. Or, you can print the notes associated with the selected Notebook entry or all of your notes. 
After making your selection and clicking Print, the standard Windows Print dialog box appears.



Pastes text from the Clipboard into the Notes window.



Undoes the previous edit made in the Notes window.



Cuts the highlighted text from the Notes window and copy it to the Clipboard.



Selects all text in the Notes window.



A Help topic is not available for this item.



Print. Click to print highlighted text or the entire topic that is displayed in the Topic 
Area.

Copy. Click to copy highlighted text or the entire topic displayed in the Topic Area. 
You can paste your selection into another application, or into your Notebook. (Open 
the Notebook window, click the right pane, and press CTRL+V.)

Navigation & Topic. Click to display the Navigation Area in the left pane while 
viewing the Topic Area in the right pane. To close the Navigation Area and display 
only the Topic Area, click Topic Only.

Topic Only. Click to close the Navigation Area and display only the Topic Area. To 
display both areas, click Navigation & Topic.

Notebook. Click to open the Notebook, where you can store a list of topics of 
particular interest, along with your own notes about them.

Glossary. Click to view a glossary of Visual Basic-related terms and definitions.

Help. Click to get Help for Visual Basic Books Online.

Add to Notebook. Click to add the selected topic to your Notebook.

Delete. Click to delete the selected topic from your Notebook.

Print. Click to print topics or your notes from your Notebook.

Paste. Click to paste selected topic text or contents of the Clipboard to your Notes in 
the Notebook window.

GoTo. Select a topic in the Notebook and then click to display the topic in the Topic 
Area.

You can also go to a topic by double-clicking the topic in the Notebook window.

Contents. Click to view the Table of Contents in the Navigation Area, and then click an entry to 
display a topic in the Topic Area.



Index. Click to view and search through an index of topics.



Find. Click to perform a precise search for a word or topic. You can type a word or phrase, or select a 
previous search string from the drop-down list. Visual Basic Books Online supports Boolean search 
operators.



Click to display Related Information, then click a topic from the list to display it in the Topic Area.



Back. Click to go back through the topics that you've previously viewed.

To view a list of all the topics that you’ve previously visited during the current session, choose History 
from the Navigate menu to open the History window.



Previous. Click to move to the previous topic in the Navigation Area.



Next. Click to move to the next topic in the Navigation Area.



The Navigation Area is in Contents pane mode. You can select a category from the Table of 
Contents, scroll through the topics displayed, and click a topic to view it in the Topic Area.

You can switch the Navigation Area to display the Index or Find pane by clicking one of these icons at 
the top of the Navigation Area:

Index. Displays Index entries 
related to particular topics in Visual 
Basic Books Online.

Find. Displays the Find pane, 
where you can perform a precise 
search for a word or topic.

The Navigation Area is in Find pane mode. You can type a word or phrase, or select a previous 
search string from the drop-down list. To search for a phrase, enclose the phrase in quotation marks.

Click a found topic to display it in the Topic Area.

You can switch the Navigation Area to display the Contents or Index pane by clicking one of these 
icons at the top of the Navigation Area:

Contents. Displays the Table of 
Contents.

Index. Displays Index entries 
related to particular topics in Visual 
Basic Books Online.

The Navigation Area is in Index pane mode. You can click the text box and type the first few letters of 
a word; the index will scroll to the closest entry and list related topics in the box at the bottom. Click 
an Index entry to display the topic in the Topic Area.

You can switch the Navigation Area to display the Contents or the Find pane by clicking one of these 
icons at the top of the Navigation Area:

Contents. Displays the Table of 
Contents.

Find. Displays the Find pane, 
where you can perform a precise 
search for a word or topic.

The Topic Area always displays content, whether it be a selection from the Table of Contents in the 
Navigation Area, a topic related to an Index entry, or the topic you've selected from the Find hits list. 
Click a topic in the Navigation Area to display it in the Topic Area.



Print Notebook dialog box. Click your selection to print the current Notebook topic or all topics 
stored in your Notebook. You can print your notes or topic text, or both.



Lists the Notebook entries, including those topics to which you have added notes. To display a 
Notebook entry in the Topic Area, double-click it; or, select the Topic and click the Go To button on the 
toolbar.

To add, edit, or delete notes for a particular topic, click the entry, then add, revise, or delete the notes 
that are displayed in the Notes window.



Displays the Notes that you have created for particular topics. Click this window to add or revise 
notes.



The History window opens to the same size and location used when last closed. You can move it or 
drag its borders to adjust its size to suit your needs.

Click a topic in the History window to display it in the Topic Area. If the Contents pane is active in the 
Navigation Area, the title of the topic displayed in the History window is selected in the table of 
contents.

Note      You must use the mouse to select a topic in the History window. The keyboard keys are 
disabled in this window.

The History window stays on top of the application main viewer until you close it.




